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Introduction
About PRMG

Our Purpose & Mission

Stylistic Approach

Brand strategy
Brand Perception

Target Market

Brand Archetypes

Client Profiles

This is a foundation 
edition of the PRMG 
visual brand guide. 

Covering the core of our visual identity, 

this guide includes detailed descriptions  

and rules pertaining to our brand and its use.

The instructions included in this guide 

are intended to ensure that all creative entities 

that work with the PRMG brand are aligned  

with and consistent with the graphic direction 

of PRMG.

Brand in use
Examples of Use

Brand Identity

Base Elements

Logo

Color Palette

Typography

Brand extension

Imagery

Graphic Language

Digital Language

Pattern

Iconography

Charts & Metrics

1. 3. 4.

2.
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About  
Pacific Rim  
Marketing Group

Pacific Rim Marketing Group (PRMG), established 

in 1985 in Melbourne, Australia, is a direct and 

digital marketing agency.

The company originally operated as a direct 

marketing agency with one single principal 

partner: Herbalife International - now known as 

Herbalife Nutrition (Herbalife). Like Herbalife, our 

mission was to make the world a happier and 

healthier place.  

Fast forward to today and PRMG is now a global 

organisation that offers more than just your 

standard marketing solutions.

Despite our increase in size, we’ve continued to 

keep sight of our goal: influencing community 

health on a global scale by marketing sound 

nutrition, physical activities and general wellbeing. 

We do this by only communicating in a way that is 

authentic and of value to our customers and their 

everyday lives. 

Today PRMG has evolved 
into a multi-faceted company,  
operating in over 50 countries

PRMG has several functions:

1.	 Digital and Social 

Media-marketing Agency

2.	 Diverse Investment Portfolio

3.	 Strategic Corporate Partner

4.	 Worldwide Real Estate Interests

5.	 Nutritional Clubs

6.	 Personal Development 

Platforms and Events

7.	 FitClubs / Exercise Hubs

Flinders Street Station, 

Melbourne, Australia.

01.
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Our mission is to influence 
community health on a global  
scale through marketing sound 
nutrition, physical activity  
and general wellbeing.

Stylistic Approach
We are a premium brand and this is  
reflected in all our design elements. 

We want to acknowledge our heritage but ensure 

we still come across as modern and relevant. So we 

draw upon colour palettes that are synonymous 

with timelessness and classic beauty. 

Navy blue, gold and marble therefore feature 

predominantly throughout our communications in 

a way that is sophisticated and refined - not tacky or 

over the top. Each element is carefully considered 

and balanced so to appear confident, professional 

and trustworthy.

Key attributes
	– Professionalism

	– Experience

	– Expertise

	– Vision

	– Knowledge

	– Unique

	– Authority

	– Global

	– Sophisticated

	– Innovative

	– Evolving

	– Prestigious

	– Wellness

	– Social
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Brand 
Strategy

02.

Brand Perception

When consumers see or hear PRMG,  

they should think: 

	– Global wellness

	– Effective marketing solutions

	– Brand experts

	– Brand development and growth

	– Influencer marketing

	– Positive social impact

	– Community health

	– Business growth 

Brand Personas

For tonal reference, some of the below 

brands are ones we've worked with,  

and the others we like.

Principal: our existing partner
Herbalife Nutrition

Tier 2:
Our contracts past  

and present

	– Nike

	– Reebok

	– F45

	– Virgin Active

	– Gymshark

	– Adidas

Tier 3: 
Universal brands  

we like

	– Apple

	– Facebook

	– Google

	– YouTube

	– Tesla

	– Google

	– Gucci

Approach to  
tone of voice

We're distinguished. This comes across in 

the way we act, not the way we say we do. 

For example, we don't use words like 'VIP' 

or 'iconic'. Our refined and understated 

delivery is what makes us those rather than 

calling them out.

While we pride ourselves on being  

a premium and sophisticated brand, we're 

also human. Not robotic or overly polite.

Make sure
Don't associate the PRMG  

brand with undesirable items like 

weapons, tobacco & alcohol and 

inappropriate items for some 

audiences such as marijuana. 

Promotion of PRMG isn't associated 

with items not able to be purchased 

with PRMG such as gambling, lottery 

tickets and foreign currency etc. 

02.
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1.	 Why? 

They are interested in improving their own 

current situation through a physical product 

result or income result. 

[Physical, Work-life, Income etc.]

2.	 Why? 

After devoting their livelihood toward  

developing a skill and related audience,  

they now wish to monetise from it.  

[Influencer or Established Business]

3.	 Why? 

They are product lovers, who in turn,  

look to positively impact the lives of others. 

[Product Result turned Product Lover]

4.	 Why? 

They are looking to monetise whilst  

on a mission / in a community working 

toward improving the way people look  

and feel about themselves.  

[Established Industry Participant]

5.	 Why? 

They are interested in generating a life-long 

income whilst enjoying the maintenance  

of a healthy-active lifestyle. 

[Income Result turned Business]

Our Target Market

1 - Businesses (B2B) 

Owners of companies or businesses which 

are customer facing for example: gym 

owners, modelling and talent agents, events 

companies with a health/nutrition/exercise 

focus, owners of sports teams, etc. 

2 - Influencer

Influencers wanting to use their audience  

to generate long-term residual income.

Suitable candidates could be: current or 

retired athletes, wellness industry experts, 

models/celebrities/influencers. 

3 - General population

Individuals with unique or interesting 

qualities who are wanting to develop these 

into a brand.

The company is effective and  

stable in its operation.

Growing, Evolving, Innovative, 

Forward thinking, Expert, 

Knowledgeable, Authority, 

Experienced, Resourceful, Stability.

We're premium and sophisticated 

- a 'billion dollar' feel.

Connect with audience

Ability to monetise 

from social media

Sustain long-term growth

Evolve with a scalable 

network

Open free-flowing  

communication channels

Fluid sales generation

Leverage value in your tribe

Start with WHY

The Five WHYs to Why PRMG

Simon Synek's - Golden Circle

How?

Why?

What?

Watch: Start with why
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How we solve our  
client's problems?

What do we want  
to communicate?

https://www.youtube.com/watch?v=u4ZoJKF_VuA


P
age —

 15

P
age —

 14

B
rand G

uide

B
rand G

uide

Brand Strategy02.

  The Creator

Examples of companies:  

Apple, Sony, Lego, Adobe, Canon

Examples of the Creator Personalities:  

Bill Gates

Key attributes:  

Innovative, Imaginative, Creative, Artistic, 

Experimental, Ambitious, Inventor, 

Musician and Writer.

Strategy:  

Gaining artistic control by  

developing skillset

Goal: 

To realise a vision

  The Sage

Examples of companies:  

Audi, BBC, PHILIPS, Google, National 

Geographic

Examples of the Creator Personalities:  

Morgan Freeman, Gandalf in The Hobbit

Key attributes:  

Expert, Thinker, Philosopher, Advisor, 

Planner, Reflective, Confident,  

Wise, Intelligent.

Strategy:  

Seeking out information and knowledge

Goal: 

To use intelligence and wisdom 
to understand the world

The Creator is a non-conforming visionary. 

He/She has a desire to craft and create only 

original ideas that are truly meaningful  

and authentic.  

The Creator finds satisfaction in both the  

process and the outcome of producing  

a product or execution. 

This makes them a natural fit for many marketing, 

design and technology brands. 

They don’t settle for mediocre or less than perfect 

– sometimes this is to their detriment. 

When in their element, they’re extremely. 

imaginative, expressive and innovative.  

While when at their worst, they’re self-indulgent, 

melodramatic and narcissistic.

The Sage seeks the truth and good in all situations. 

Sage brand types are curious, positive and 

intelligent. Brands which appeal to them are 

innovative, explorative and inquisitive. They prefer 

language that is considered and imagery that 

 is symbolic. 

The Sage finds the most fulfillment in discovering 

answers to the most challenging questions. 

Whilst they demonstrate intelligence, knowledge 

and proven problem-solving skills, Google is 

probably the most significant Sage brand of  

our time. 

At his/her best, The Sage is wise, open-minded 

and articulate. 

At his/her worst, The Sage can be perceived  

as self-absorbed and or cold. 

  The Ruler

Examples of companies:  

Grey Goose Vodka, Rolex, Porsche, Google

Examples of the Creator Personalities:  

Beyonce,  Barack Obama

Key attributes:  

Manager, Organiser, Leader, Role Model, 

Productive, Confident and Responsible.

Strategy:  

Exercising power through leadership,  

not micro-management

Goal: 

To create a prosperous, 
successful community

The Ruler is driven by their strong willpower and sense 

of control. 

Ruler brand types are authoritative in their tone and 

demeanour, and so common perception is that they are 

the leaders. In most cases, this tends to be true. 

While the Ruler is an archetype held popularly by males, 

females aren’t excluded.  

One of The Ruler’s defining features is his/her ability to 

remain calm and composed in stressful situations. The 

Ruler is also known for being reliable, grounded and 

responsive. He/She often uses his/her authority to calm 

the room, inspire productivity and create change. The 

Ruler does from time to time risk being too dominating, 

overly hierarchical or political. 

P
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Meet our 
Archetypes

We’ve defined our content 

creators and partners into 

three archetypes. 

This helps us to better 

understand how they prefer  

to connect and engage with 

their audience.

Here are the 3 archetypes selected for PRMG:
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Client Profiles 	– Age Range: 25 - 54.

	– Lives and works within a community of individuals.

	– Already established in the sports, wellness, healthy lifestyle 

or nutrition industries.

	– Maintains a digital presence on social media.

	– Demonstrates desirable qualities including but not limited 

to: motivation, dedication, focus, energy, proactivity, 

autonomy and the ability to be a team player.

	– Owners of companies or businesses that are customer-

facing (e.g Gym Owners, Personal Training, Group Exercise 

Instructors, Physiotherapy, Nutritionist, Modelling Agents, 

Talent Agency, Nutrition Stores, Activewear Company, Sports 

Club Owners/Managers/Coaches, Health/Nutrition/Exercise/

Sports based events companies)

	– Talented marketers wanting to use their skills to develop 

digital tools which facilitate: 

	– Lead generation

	– Sales

	– Short-term retail and wholesale profit

	– Medium-term commissions

	– Long-term residual income through inner and outer 

nutrition products

At the same time, these marketers must share PRMG’s goals 

for influencing community health on a global scale, making 

the world a happier and healthier place. 

	– Influencers wanting to leverage the value of their audience 

to generate: 

	– Short-term retail and wholesale profit

	– Medium-term commissions 

	– Long-term residual income through inner and outer 

nutrition products

At the same time, they must share PRMG’s goals for 

influencing community health on a global scale, making the 

world a happier and healthier place. 

See our 6 personas
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She lives in a South Yarra share house, 

conveniently located for a trendy, fast  

paced lifestyle. 

Active on social media, Gabrielle frequently 

checks Facebook, Instagram, Pinterest  

and Snapchat as a source of information, 

posting only when there's 'something 

interesting'.

Gabrielle finds social media use to be quite 

restrictive during her professional career 

She uses Apple products for her technology 

needs. She is not afraid of trying new things, 

however, she leans toward proven and 

tested solutions. 

In this way, Gabrielle will accumulate 

as much information as possible before 

making a purchase, turning to friends and 

looking at trends typical of her circle of 

influence (COI). 

Gabrielle loves to travel, but lives  

a constricted, prudential lifestyle.

The occasional shopping splurge  

and driving getaway is a luxury  

that Gabrielle cannot afford to maintain. 

She aspires to one day travel the globe, 

exploring local cuisines, cultures and 

people.

Pain Points

	– Gabrielle's online research has 

made her wary of the negative press 

surrounding Herbalife. 

	– She wants to be financially independent 

but scaredof change. Without the 

security of her job, Gabrielle does not 

have sufficient savings to keep up with 

her bills.

	– She is unsure if the products work and if 

distributing the products independently 

counts as a 'real job'.

	– Gabrielle wants to inspire others, by 

sharing in the pleasure of good and 

healthy food. Also, Gabrielle wants to 

make sure people have unforgettable 

experiences, and influence them to 

travel to destinations she has enjoyed. 

She does not want to force anyone  

to buy a specific product.

Gabrielle is a talented 28-year-old  

with an associate degree. 

Three years ago, Gabrielle moved out 

of home and travelled to Australia from 

London to try and uncover her life's 

purpose. Nowadays, Gabrielle works at a 

popular hotel, excelling in her role  

as concierge. 

Client's frequently report positive feedback  

on Gabrielle's recommendations.

Whilst everyone loves working with 

Gabrielle, she is dreaming about her life 

outside of a 9-5.

Gabrielle maintains a healthy lifestyle 

by going to the gym each morning and 

preparing healthy meals for her everyday lunch. 

She spends limited downtime following food 

and lifestyle blogs, and regularly interacts  

with her co-workers come friends.

Gabrielle is often the centre of attention 

amongst colleagues interested in healthy 

food, popular culture and trends. 

She considers herself an adventurous eater, 

spending most of her limited disposable 

income on food and occasional shopping 

splurges. 

Stranger  
Dissatisfied Current Situation

Name
Gabrielle Cleary

Age  
28 years

Highest Level of Education  
Bachelor Degree (Arts)

Job Title  
Concierge

Technology Use
High - Personal Social Media

Brand Affinity
Apple, Patagonia, Four Seasons Hotel, Zimmerman

1



P
age —

 21

P
age —

 2
0

B
rand G

uide

B
rand G

uide

Brand Strategy02.

Ryan is a 40-year-old retired elite level athlete.

He trained as a professional footballer and was 

successful for a number of years. His greatest 

achievement was winning the English league’s Rising 

Star Award in 1998 at only 19 years old. 

Throughout his career, Ryan has played for a range  

of teams. Coaches and team members loved Ryan for 

his energy but recognised he was unlucky when it 

came to playing. Even after his professional sporting 

career ended, Ryan remained active in the sporting 

world. Unfortunately no high-level opportunities 

opened up. To this day, he’s still remembered for 

his commitment to the sport and is fondly regarded. 

There however lay an opportunity to build on  

his legacy.

Currently, Ryan has investments in gyms. This seems 

to serve him well as he has some one off payments 

coming his way.

Ryan knows how to promote himself through his 

social media channels. He’s successfully built a 

relationship with his audience off the back of his 

unfiltered, candid and raw photography and caption 

styles.  While he mainly profits from the sporting 

career he once had, he lacks direction on how to 

grow and expand it for new business opportunities.

Ryan wants to be one of the best while continuing to 

nurture his audience.

Pain Points

	– He wants to use his market position to leverage 

value and generate an income but he has no  

idea how to.

	– Ryan lacks focus and clear direction. 

	– Requires an immediate and steady cashflow.

	– He wants to generate a business now that his 

paying contract is complete. He is looking for  

new sources of income, through a safe and 

reliable system.

Fitness Trainer  
Industry Expert

Name 
Edward Knaggs

Age
34 years

Highest Level of Education  
Certificate 3 Personal Trainer

Job Title  
Fitness Trainer

Technology Use 
Moderate

Brand Affinity
Nike, Redbull, Spartan 

Race, Gym Shark, Jeep Motor

Edward is a 34-year-old fitness veteran. Sport 

throughout school and university inspired him to 

remain physically fit and mentally healthy. 

He shares this passion with others for he is 

a highly skilled and valued personal trainer. 

His experience stretches across most sports 

and physical activities. He also has a sound 

understanding of wellbeing. 

Thanks to his hard work, Edward maintains 

a great physical appearance and serves as 

inspiration for many of his clients and co-workers. 

Edward is successful in the world of fitness 

instruction, working out of a multi-disciplinary 

gym/exercise facility.

He occasionally shares client results, personal 

bests and other parts of his daily life on social 

media.  

2

He uses Facebook and Instagram every so often,  

though prefers real-life interactions with his clients  

and friends.

Edward's personal brand is that of an industry expert. 

He is the authority for his closest friends and people 

with whom he works with.

Edward wants to improve and broaden his knowledge, 

expanding into nutritional advice to help others. He 

aims to raise awareness and help others achieve a 

well-balanced and healthy lifestyle. At the same time, 

Edward is conscious his career depends on his physical 

appearance so he is wary to maintain a healthy and 

active lifestlye.

Pain Points

	– Edward wants to develop his brand in various 

areas related to a healthy lifestyle - not only fitness 

training. This could be through offering a nutrition 

service or personalised training programs.

	– He wants to advise his clients comprehensively, (e.g. 

help in choosing the right diet for the right kind of 

training), but without any brand or visual identity, 

he thinks no one will take his business seriously.

	– He want to share his journey, including when he 

wins and fails. By doing this, he hopes to motivate 

young athletes and fitness trainers. Edward has 

always gone it alone, so he needs advice and 

mentorship to guide his growth, scale his business 

and communicate/educate his audience.

Influencer  
End of Currency Window

Name
Ryan Paramor

Age
40 years

Highest Level 
of Education  
High School Degre 

Job Title  
Retired athlete, earns income 

through endorsements and 

one time payments

Technology Use 
Moderate

Brand Affinity
Lexus, Tag Heur, Reebok, HBO

3A

Edward 
34 years

Ryan 
40 years
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Influencer  
Start of Window

Name 
Stacy Stevens

Age 
21 years

Highest Level of Education  
High School Certificate, Currently 

studying an Undergraduate Degree  

in Media and Public Relations

Job Title  
Part-Time Model,  

Part-Time Retail Assistant

Technology Use 
High

Brand Affinity
Lululemon, Kylie Jenner, Nike, Off-White

Stacy is a 21-year-old modern day internet 

sensation. She grew up in the digital age so 

naturally, her mobile phone is an extension of her 

arm. She couldn’t be more suited to be a lifestyle 

influecer.

On Instagram alone, she has a cool 100k 

followers and her YouTube channel averages 45k 

views. Stacy is always at local events, reviewing 

restaurants, bars and start-up products. Wherever 

the action is, Stacy is there. 

Right now, cash flow is good with a few brands 

offering some modest endorsement money for 

brand use and product placement. As Stacy lives 

at home with her family, this works well for her. 

She does however enjoy the occassional splurge on the 

latest must-have item or a summer holiday in Europe.

After the next trip abroad, Stacy wants to save up for a house 

and fund her own influencer based social media business. 

Online, Stacy is confident but is still refining her skill  

for communication to large groups in person.

In all, Stacy is highly sought after, but ultimately, she  

must commit to one career path if she truly wants to 

experience success.

Pain Points

	– Stacy wants to use her position on social  

media to generate an income but has yet 

to decide a long-term direction or strategy.

	– Stacy is reluctant to be ‘tied-down’ to one opportunity for 

she wants to remain current and on trend in the fashion 

world.

	– She is unsure about how this brand alignment will affect 

her public perception.

Thought Leader  
Related Business Owner

Name 
David Levinson

Age 
50 years

Highest Level  
of Education  
Bachelor of Laws, Bachelor of Commerce

Job Title  
Investor

Technology Use 
Moderate

Brand Affinity
Hugo Boss, Porsche, Rolex,  

Canali, Montblanc

Previously a lawyer, 50-year-old David now spends 

his time investing in new business ventures like 

commericial property; and maintaining his public 

appearance. As a successful businessman, David 

is seen as a bit of a guru. He frequently uses his 

personal network to launch new ventures and grow 

his assets. 

David is familiar with network marketing, however 

it’s never really been for him. He recognises that 

public perception and the uncertainty of it all could 

cost him the appearance he’s worked hard to build. 

Until now, David was focused on himself, but with 

age, his focus has shifted to community health. He 

feels a sense of responsibility when it comes to  

social impact. 

As a result,, David now participates in semi-regular exercise, 

walks with his wife and the dog on weekends and invests  

in nutritious foods, healthy meals, and businesses  

with positive social implications. 

With this, David has invested in the set-up of several 

gyms, an activewear brand and an online work-out 

regime alongside some industry heavyweights. 

Distributing health products with his team could 

be David's next big move, if he's prepared to allocate 

the time.

Pain Points

	– David has several other viable commercial 

opportunities that are less costly in terms of  

time resource.

	– He is uncertain about exposing his current 

structure to a new commercial opportunity.

	– David understands the model but is motivated  

by short-term returns as opposed to focussing  

on long-term investments.

3B 4

David 
50 years

Stacy 
21 years
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Product  
Product Lover

Name 
Jim Brewster

Age 
32 years

Highest Level of Education  
Builder

Job Title  
Tradie (Brick Layer)

Technology Use 
Low

Brand Affinity
Holden, Hard Yakka,  

Four n Twenty, AFL, Victoria Bitter 

For 32-year-old Jim, nothing is better than a cold beer  

with the boys after a long day on the tools. 

As a builder, Jim spends plenty of time in a masucline 

environment, eating his fair share of unhealthy  

on-the-go foods.

Like his mates, Jim wasn’t too fussed about food or his 

figure until one day, he realised he could no longer 

climb the ladder. This because he is over the weight 

restricition.

Jim has now made the decision to take responsibility for 

his health. He’s looking for health and nutrition advice 

and products he can trust to work. 

He's excited to get in shape, lose weight, improve 

his energy and feel better about himself.  

Pain Points

	– Jim loves his food and is considering  

whether he can simply eat healthier meals,  

instead of substituting 'real food' with powders.

	– He is uncertain about the way he will be perceived by his 

work colleagues if he is seen to be eating differently.

	– Jim is self-conscious about his weight  

and is uncomfortable talking about it.  

He needs a mentor he can trust and a plan  

he can understand before he gets started.

5

Jim 
32 years

02.
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Logotype

The PRMG logotype is the first thing 

customers will see and learn to recognise.  

It should therefore be treated accordingly. 

The logotype is symbol based on an abstract 

representation of the globe. Each ‘point’ 

references a specific place in the world, and 

emphasises the company’s global operations.

Some of the points are connected. This 

is symbolic to what PRMG does: connect 

markets, brands and people. 

The Earth's axis is tilted 23.5 degrees  

from the plane of its orbit around the sun.

If the Earth weren't tilted on its axis,  

there would be no seasons and humanity 

would suffer.

In our case, it symbolizes the brand's 

flexibility - adapting to the needs of its 

customers and the world’s evolutions.

23.5°

Brand 
Identity

03.
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Logo —   
Construction

Based off the Golden Ration, the PRMG 

symbol is a very considered designed.

Wordmark is written in Sofia Pro font.

However, to emphasize the stable position 

of the brand, the letter M was converted 

and gained a more monumental character.

Golden ratio

Logo construction 

and the proportions

Logo —   
Clear space

Clear space is separating the logo from 

other elements such as headlines, text, 

imagery and the outside edge of printed 

materials. 

The ‘x’ below is equal to half of the  

logo symbol.

4x

x

2x

2x

x

x

0,3x

x

x

x x x x

x x

Clear space

horizontal version

Clear space

vertical version

x

2x

x

x

x x

x

x

x

4x

0,3x
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Logo —  
Size

A logotype that is too small and thus illegible, will lose  

its strength.

Therefore, the logo size should always allow for 

trouble-free reading as it’s the brand name.

The minimum logo size for print media is 15 mm  

wide and 6 mm high. For digital media, it is 50 px wide  

and 20 px high.

Below are examples of how the logo will look  

in different sizes.

5mm

Logo —  
Variations

Primary versions

We have several variants of the logo.  

They should each be used where needed 

and in line with the guidelines. 
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Logo —  
Variations

Long name versions

We have two variations of a long name logo.  

First one - a symbol with a full brand name, 

and second - primary horizontal logo  

with a small caption.

Example of use

- Wall Signage 

- Window Signage 

- Plaque Office 

- Billboard

Example of use

- Watermark 

- Certification Element 

- Stamp 

- Social Profile Picture 

- Favicon

  
 

Icon and stamp version

The stamp and icons are alternative 

versions of the PRMG logo.   

They can be used as a decorative 

element or watermark.
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Logo —  
Incorrect use

As the logotype is quite symbolic, any modification of it will 

contradict its meaning and diminish its impact. Change is 

therefore not allowed. Precise logo artwork has been created 

to accommodate any usage needs.

Never redraw, translate or otherwise alter our logo in any 

way. The following list of incorrect usage must be avoided  

at all times to maintain the integrity of our brand.

Do not
Rotate or stretch

Do not
Re-create the logo

Do not
Use any effects

Do not
Use gradient

Do not
Add new details

Do not
Changes proportions

1. 

2.

 

3.

4.

 

5.

 

6.

Be loud by you

Colour palette

Our colours define our brand. 
It is essential that our use  
of colour be consistent across  
all applications. 

The primary colour of the brand is dark 

blue steel. It is the most intense colour,  

depicting depth, trust, loyalty, sincerity, 

wisdom, confidence, stability, faith,  

heaven, and intelligence.

The blue is also associated with  

the burgeoning contemporary tech 

industry and digital marketing culture.

Devolving from mahogany brown, 

the secondary colour of gold is included. 

The colour gold is associated 

 with illumination, love, compassion,  

courage, passion, magic, and wisdom. 

Like the precious metal, the colour gold  

is also associated with wealth, grandeur,  

and prosperity. 

This colour is used to add texture and 

elevate the level of luxury that PRMG 

will deliver (on business cards, folder, 

invitation). 

Primary - Dark Steel Blue

PANTONE 296 C

CMYK 100/87/48/66

HEX #12192E

Teritary - Dark Marble

PANTONE Cool Gray 7 C

CMYK 39/31/33/10

HEX #9E9D9A

Secondary - Gold

PANTONE 872 C

CMYK 23/38/67/11

HEX #BC945C
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Colour palette —  
Shades

The additional colours of the PRMG brand are different  

shades of primary colors.

If you print under the press in two colors (Example: letterhead / 

Business card), it is recommended to use Pantone.

On the other hand, if you are printing digital 

or you have more than 2 colours to print (Example: brochure  

with photographs), it is advisable to print in CMYK (CMYK).

CMYK 100/87/48/66

HEX #12192E

RGB 18 / 25 / 46

PANTONE 296 C 

CMYK 23/38/67/11

HEX #BC945C

RGB 188 / 148 / 92

PANTONE 872 C

CMYK 39/31/33/10

HEX #9E9D9A

RGB 158 / 157 / 154

PANTONE Cool Gray 7 C

CMYK 76/63/43/38

HEX #414758

RGB 25 / 71 / 88

CMYK 19/31/50/6

HEX #C9A97D

RGB 201 / 169 / 125

CMYK 23/17/19/1

HEX #CDCCCA

RGB 205 / 204 / 202

CMYK 57/45/34/19 

HEX #717582

RGB  113 / 117 / 130

CMYK 13/20/31/1

HEX #E4D4BE

RGB 215 / 191 / 157

CMYK 10/7/9/0

HEX #EAE9E8

RGB 234 / 233 / 232

CMYK 39/31/33/10

HEX #D0D1D5

RGB 208 / 209 / 213

CMYK 5/7/11/0

HEX #F2EADE

RGB 242 / 234 / 222

CMYK 4/3/4/0

HEX #F8F7F4

RGB 248 / 247 / 244

CMYK 22/16/14/0

HEX #F3F3F4

RGB 243 / 243 / 244

CMYK 1/2/2/0

HEX #FCFAF7

RGB 252 / 250 / 247

CMYK 2/2/2/0

HEX #FAF9F8

RGB  250 / 249 / 248	

Typography

Typography is a strong extension of our brand personality. 

Primary typeface is Sofia Pro. It is a modern sans serif font 

with geometric proportions. Sofia Pro font is clean and easy 

to read. It is recommended all headings. 

The secondary typeface for body copy on printed and online 

materials is Noto Sans. This font is intended to be visually 

harmonious across multiple languages, with compatible 

heights and stroke thicknesses. 

Noto Sans has a more natural reading rhythm,  

commonly found in humanist and serif types.

To distinguish words in headers or text, we can use  

the Anko font as an additional typeface. 

Anko font gives a prestige and classic feel to the brand.

Primary typeface

for heading and titles

Secondary typeface

for body copy

Additional typeface

for highlighted elements

Sofia Pro
A B C C D E F G H I J K L M N O P Q R S T U V W X Y Z

a b c c d e f g h i j k l m n o p q r s t u v w x y z

1 2 3 4 5 6 7 8 9 0 ! # $ & * ( ) _

Noto Sans 
A B C C D E F G H I J K L M N O P Q R S T U V W X Y Z
a b c c d e f g h i j k l m n o p q r s t u v w x y z
1 2 3 4 5 6 7 8 9 0 ! @ # $ % ^ & * ( ) _

Anko
A B C C D E F G H I J K L M N O P Q R S T U V W X Y Z

a b c c d e f g h i j k l m n o p q r s t u v w x y z

1 2 3 4 5 67 8 9 0 ! @ # $ % ^ & * ( )_

B
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Download indesign swatches

https://drive.google.com/open?id=12bQK0IszuLByhqK6M5rTa8vs44dDqpZD
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Typography —  
Example of use

On a light background On a dark background

The Emerald Buddha is a figurine 
of a sitting Budha, that is the 
palladium of the Kingdom  
of Thailand. 

The Buddha is made of green jade, 
surprisingly not of emerald, clothed in gold, 
and is approximately 45 cm tall. The Buddha 
is kept in the Chapel of the Emerald Buddha, 
which is located on the grounds of the 
Grand Palace in Bangkok.

Where was created the  
Emerald Buddha?
Legend tells us that the Emerald Buddha 
was created in Pataliputra, India, which is 
now the city of Patna in 43 BCE by Nagas.

Other great historians believe that it 
belongs to the Chiang Saen Style of the 15th 
century. 

The legend says that it remained in 
Pataliputra for 300 hundred years until  
it was taken to Sri Lanka to save it from  
a civil war. 

It was then in 457, that King Anuruth  
of Burma sent out orders to Ceylon  
to ask for the Emerald Budha and Buddhist 
scriptures. 

These actions took place by the king,  
to try and support Buddhism in his country. 

The Buddha made it’s way through 

several hands after that: Ayutthaya, 

Kamphaeng Phet, Lao and finally  

Chiang Rai. 

It was finally in Chiang Rai that the ruler  
of the city hid it. It wasn’t until 1434  
that sources indicate the resurfacing  
of the statue in Northern Thailand. 

The Emerald Buddha is a figurine 
of a sitting Budha, that is the 
palladium of the Kingdom  
of Thailand. 

The Buddha is made of green jade, 
surprisingly not of emerald, clothed in gold, 
and is approximately 45 cm tall. The Buddha 
is kept in the Chapel of the Emerald Buddha, 
which is located on the grounds of the 
Grand Palace in Bangkok.

Where was created the  
Emerald Buddha?
Legend tells us that the Emerald Buddha 
was created in Pataliputra, India, which is 
now the city of Patna in 43 BCE by Nagas.

Other great historians believe that it 
belongs to the Chiang Saen Style of the 15th 
century. 

The legend says that it remained in 
Pataliputra for 300 hundred years until  
it was taken to Sri Lanka to save it from  
a civil war. 

It was then in 457, that King Anuruth  
of Burma sent out orders to Ceylon  
to ask for the Emerald Budha and Buddhist 
scriptures. 

These actions took place by the king,  
to try and support Buddhism in his country. 

The Buddha made it’s way through 

several hands after that: Ayutthaya, 

Kamphaeng Phet, Lao and finally  

Chiang Rai. 

It was finally in Chiang Rai that the ruler  
of the city hid it. It wasn’t until 1434  
that sources indicate the resurfacing  
of the statue in Northern Thailand.  story 
about the discovery.

The Emerald Buddha 
mystic figure

The Emerald Buddha 
mystic figure
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INFLUENCER SOLUTIONS

Connect with the brands you love and the 
projects you're passionate about.  
Our Global Influencer Program is entirely 
free for influencers and digital creators.

Unlimited Possibilities
We'll continue to present profitable 
opportunities until you reach your 
maximum workload capacity.

Direct Payment System
All revenue is automatically distributed on 
agreed dates, so you never have to worry.

Full Control
You choose the brands you work with 
so there's no conflict with existing 
partnerships.

We grow profiles.

Column One Column Two Column Three Column Four Cwolumn Five

Value One 100 100 100 10% further reduction 
over 3 year period

Value Two 100 100 100 10% further reduction 
over 3 year period

Column One Column Two Column Three Column Four Column Five

Value Six 100 100 100 100

Value Seven 100 100 100 100

Value Eight 100 100 100 100

Typography —  
Example of use cd.

Excel Sample Data

Tabular data presented in a simple 
and clear way.

Typography —  
General rules for formatting content

When creating content, use the grammar 

rules of Australian English which is the 

corporate language of PRMG.

Pay close attention to:

Headline

	– The headline shouldn't have  

a full stop. 

	– The gold word could be inserted 

into the main headline only. 

	– The main headline should be 

concise and not exceed 2 lines  

of text.

Subheadline

	– A subheadline should always end with 

an appropriate punctuation mark.

Headline and body

	– The colour of the texts should 

be contrasted enough to allow 

easy reading on light and dark 

backgrounds.

	– In any format, all content shouldn't 

be Uppercase - including social 

media posts and ads.

OrderDate Region Rep Item Units UnitCost Total

1/6/2016 East Jones Pencil 95 1.99 189.05

1/23/2016 Central Kivell Binder 50 19.99 999.50

2/9/2016 Central Jardine Pencil 36 4.99 179.64

2/26/2016 Central Gill Pen 27 19.99 539.73

Vellataspit eium exeria si que nes eos et rernatur, seque int. Hic tempori tiorera tempos preribus doluptam aut 

ut que cus expernatium apelles maximendis ma videstrum es magnia nobit harcilit quiate et, omniminimus dolut 

quiate officim arumus que occus Pa sunt demque placero ditatem aut assit quae vellataspit eium exeria si que nes 

eos et rernatur, seque int. Hic tempori tiorera.

Full stop in main 
headline

Uppercase in 
headline

Gold colour only  
in main headline

Too small  
contrast

B
rand G

uide
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Colours & Tones

It's important to keep the same Warm / Woody / Earthy / 

Natural tones for all photographs that you combine  

with the PRMG brand. 

Capture authentic moments

People should be shown at ease and content rather than 

posed, staged or overly cheerful. Viewers are naturally  

more drawn in when people in a photograph appear real  

and truly engaged in their activity. 

`Subject(s) should appear in natural positions and situations 

as if enacting a scene rather than being static and/or posed.

Posing in perfect angles loses or destroys the authentic 

connection.

Use authentic lighting 

Lighting should look natural even if it is artificial, and we 

should never be able to tell a photo is lit. 

Present natural environments

Do not clip people and object out  

of their original environment. 

Never show overly manicured environment. 

Consider the point of view

Explore interesting yet authentic angles 

to capture an everyday task. A creative point of view  

makes subjects look engaged in the scene rather  

than just spectators.

1.

2.

3.

4.

5.

Imagery

To ensure our images represent our brand 

personality and, in turn, engage viewers 

and help them feel part of the experience 

pictured, make sure the photographs  

you select or shoot for PRMG.

We deliver marketing communications  

with a distinguishable, emotional 

and personal brand.
Download LIGHTROOM PRESET

Imagery —  
Examples

Do show authentic,  

real-life interactions 

between people. 

Do show natural expressions 

and depth of field.

Do capture people  

in spontaneous moments 

when subject is looking  

at the camera. 

 

https://drive.google.com/open?id=1HhOzynTr1B79pS76MtWHgYTpirPBczLA
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Imagery —  
Examples cd.
Do show real-life situations.

Do capture authentic lighting.

Do consider different 

perspective in imagery.

Graphic language

The graphics language of PRMG is reflective of the rest 

of its identity; straightforward, uncluttered and accessible.  

The message of each asset should be instantly clear. 

PRMG design is geometric with reference to nature  

and obeys a grid system. In this way, simple shapes  

can be effective visual tools. 
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Graphic language — 
Grid

Keep your layouts organized. 

Use the grid and align your type to it.

There are endless positions with creating  

a composition with type.

In
flu

en
ci

ng
 c

om
m

un
ity

 
he

al
th

 o
n 

a 
gl

ob
al

 s
ca

le
w
w
w
.p
rm

g.
co
m
.a
u

Influencing community 
health on a global scale
www.prmg.com.au

Graphic language — 
Sample usage

Influencing com
m

unity 
health on a global scale

w
w

w
.p

rm
g

.com
.a

u

U N I

Q U E

NE S S
www.prmg.com.au
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Graphic language — 
Layout example

Borenem volorer ectias nem quunto 

intur, con rese que coraturem 

ectias quunto intu Aqui aboritiam 

incimus ditatur as repedis imusciate 

mossectem quas aligeni hilluptate 

endia nes sit quas sit, officiatiis aut 

archill oritiatum ipsandit fugit ut 

asperum laut ea consequaspit omnim 

Haribus et prat odis dolores cilibusa 

aut rerum eostruntur?

Nem se odi omnis etus intia Ga. Lorit 

veris ea quia conse rehenihil impelec 

tempore, omnitaquis et reratur 

sitatur as aut quossit id est, quia 

nonsequodis as non nobit, sapit et hil 

inctatiis eum is quosa invel iusam.

No of users

4.5m

Daily Interactions

330,000

Device

Mobile

Influencing 
community health  
on a global scale
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Graphic language — 
Layout example

Borenem volorer ectias nem quunto 

intur, con rese que coraturem 

ectias quunto intu Aqui aboritiam 

incimus ditatur as repedis imusciate 

mossectem quas aligeni hilluptate 

endia nes sit quas sit, officiatiis aut 

archill oritiatum ipsandit fugit ut 

asperum laut ea consequaspit omnim 

Haribus et prat odis dolores cilibusa 

aut rerum eostruntur?

Nem se odi omnis etus intia Ga. Lorit 

veris ea quia conse rehenihil impelec 

tempore, omnitaquis et reratur 

sitatur as aut quossit id est, quia 

nonsequodis as non nobit.

Influencing 
community health  
on a global scale

No of users

4.5m

Daily Interactions

330,000

Device

Mobile
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Digital language

The digital language of PRMG defines  

the rules for creating multimedia content. 

This is an expansion of our graphic 

language - a more detailed description  

of specific elements that may be used  

in digital campaigns and more. 

Typography in digital content

The general typography rules for the PRMG  

also apply to our digital content. Compared to the 

website, the font size can be increased, depending 

of the tone of the video. It has to be legible and so 

there should be a noticeable contrast.

General rules for text formatting:

	– Regular font-weight for multilines body text.

	– Semi-bold font-weight for headlines  

and keywords.

	– The line height should be consistent  

with the brandguide.

	– In any format, all content shouldn't  

be uppercase.

	– Never use exclamation marks and full-stops  

in headline and keywords. Question marks  

are allowed.

	– Media text should be large and easy to read. 

	– Only feature keywords to support the voice 

over. There's no need to spell out like, :,  

and or., etc. 

	– Opt for quick descriptions over long text. 

	– You can use mixed reality eg. text merged  

to video. (Example)

Consider media context: 

While captions and copy should follow  

the brand guidelines closely, there is flexibility  

when considering the media context. 

Example: using emojis when trying to convey  

the media message more directly and playfully  

is fine in social media only. However we would not 

use emojis in eDMs. 

The length of the text

	– Have no more than 30% of text on images  

for paid ad creatives. The ideal percentage 

of text is 20%, which optimises results for 

Facebook ads.

	– For organic content, there is no restriction on 

the amount of text on the image. For example, 

if we are providing tips/quotes as an organic 

post, there is no problem going over 30% text 

on the image.

Use semi-bold font-weight for headlines.

Do not cut the text and keep the appropriate line-height

Do not use commas at the end of headings/keywords.

Be consistent with our brand guide and use quick 

description and avoid long text when the video  

sequence is short. 

Use floating elements (graphics/text) that support 

the sequence.

Do not use uppercase.

See our general information about:
Colour palette - pages 35-36
Typography - pages 37-41

https://gfycat.com/pl/decentpoliticalbarracuda
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Video captions should be legible and have  

the appropriate size adapted to the movie format. 

A caption should always be presented on a dark 

background. 

Caption copy can use full-stops, question marks, 

or emojis at the end with no punctuation.  

Note: do not use exclamation marks.

Examples caption dimensions  
for the 1920x1080px video:

Font:

	– font family: Sofia Pro Semibold

	– font size: 46px

Background:

	– background color: #12192E

	– opacity: 72%

	– padding: 12px/32px/12px/32px  

(top/left/bottom/right) 

Video format

The video format should be adapted  

to the platform on which it will be presented  

(Youtube, Facebook, Instagram Story).

Never change the format in the middle  

of a video. 

Example: Don't use horizontal 16:9 black bars  

on top/bottom ("letterbox") for 2-3 sec, then come back 

to another format. If you decide to use this horizontal 

format with black bars (emotional video for example), 

keep this format through the entire video.

Video caption style

Use graphic that illustrates the voice over.

Support video with graphic element

Do not use high contrast graphics as a background 

of the texts.

Make sure the contrast between background  

and text is high enough.
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Devices in video

Do not use flat style mockups and older  

generation devices.

When we use 3D mockups, use realistic perspective with appropriate shadow and lightning.  

Use the realistic UI element of iOS/Mac OS like email template, web browser, post card.

Use mockups of the latest Apple devices.
Emphasise realistic context. Example: Video Zoom can't be full screen, we should display  

the browser or App layout

Use real mockup with native UI elements.

Always use the right ratio, related to the screen of the device.

Do not show video on full screen without application UI.
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Devices in video

Use the realistic UI element of iOS/Mac OS  

for speech bubbles.

Always present screen with a mockup of the device or web browser UI.

Do not show mouse cursor on mobile  

when we have interactions.

Use realistic email template of iOS/Mac OS.

Do not use website preview without web browser interface.
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Pattern

Dots connected are the elements  

that represent the brand, in a visual way.

Patterns are usually used to support  

content as images or text.

When executing for digital, it is 

recommended to use patterns with  

a parallax effect.   
On a light background On a dark background



P
age —

 63

P
age —

 62

B
rand G

uide

B
rand G

uide

Brand Identity03.

Iconography

Pixel-perfect icons should be 

subtle and made from outlines. 

Icons should have an appropriate 

thin stroke size and always scaled 

proportionally.

Rounded 
Angles

Consistent  
Stroke

Consistent 
Spacing

	 Work Independently or in a Team

	 No Schedule

	 Work Remotely

	 Maintain Creativity

	 Rapid Business Development

	 Build your Team

	 Multiple Markets

	 Multiple Currencies

Example of list with icons

7. Implement social media  

and content strategy to develop 

brand awareness

4. Partner with influencer  

to develop an online  

content strategy

1. Register information  

necessary for remuneration  

and marketing license

2. Learn and understand  

the marketing strategy

5. Collect social  

media content

8. Leverage brand  

equity in audience  

to promote wellness

3. Study and trial health  

and nutrition products

6. Develop  

a unique brand

9. Build a team  

of  like-minded  

team members
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Charts & 
Metrics

Consistency when it comes 

to display charts is major 

for PRMG.

Delivering metrics  

are the main values 

 of the company.

Flat design is the direction  

to design charts.

Quiae sitatint ex eum quuntias sin nihil et aut etus ut experit que et off iciatur, quid ute volorec ullition re conet porunt a et laborepra quate 
volum quia voloribea si ut quiatquatium reptatat idenit mo tempos etur sequia sint ullecearciam adit voluptatior aut rernati ssequia et 
fuga. Tet fugit illuptatem doluptatia volor atus vel moluptatem cusciiscimet minietum rero tet a quam re volo dente arum a sit qui dit quam 
quatur, samendipic tem et optatia conemporum fuga. Ihilluptus inctur, conseque pe pre aut vellani hillaut off icimi, odistio nsequid eos evel 
ex explit aut as sa quat doluptium haritatiae velique susapid quiatiam quo inullor.

30%
STATISTICS

Arumus que occus a assit quae 
vellataspit eium Ehendignim  
Orionse molorem nos

123
STATISTICS

Arumus que occus a assit quae 
vellataspit eium Ehendignim  
Orionse molorem nos

12
STATISTICS

Arumus que occus a assit quae 
vellataspit eium Ehendignim  
Orionse molorem nos

+4.3
STATISTICS

Arumus que occus a assit quae 
vellataspit eium Ehendignim  
Orionse molorem nos

1% 24%12% 48%
Arum cuptae nonsequi 
eatiunt qui

Ademque placero  
sam

Ademque placero sam 
Arum cuptae

Ademque placero sam 
Arum cuptae nonsequi

4/12 600+3.1 1/12
Ademque placero sam 
Arum cuptae nonsequi 
eatiunt qui nonsedis 

Ademque placero sam 
Arum cuptae nonsequi 
eatiunt qui nonsedis

Ademque placero sam 
Arum cuptae nonsequi

Ademque placero sam 
Arum cuptae nonsequi 2.8M

300M

500M 
Millions people  

were obese (2008)

1.5B 
Billions adults  

were overweight (2008)

Millions people die each year globally,  
as a result of being overweight or obese.

Millions people die from being overweight 
or obese In the South-East Asia Region.
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96%

Arumus que occus a assit quae 

rerionse molorem nos Delitat vellab 

intium eos aut volupta tibus.

Nam libero tempore, cum soluta 
nobis est eligendi optio cumque 
nihil impedit quo minus id.

12%

Que occus a assit quae re 

Orionse molorem nos

1.2 Que occus a assit quae rionse molorem nos

36%

Arumus que occus a assit  

quae onse

24%

Arumus que occus a assi  

eionse molorem nos

48%

Lorem occus a assit quae 

rionse molorem nos

Dem et a voles ilit aut et 
offictest, ut harunto vendae 
Vendit etur apitatum aut ese 
magnim fugia is dunt.

Arumus que occus a assit quae rerionse molorem nos 

Delitat et vellab intium eos aut volupta tibus, quis quae 

voluptas vollene mporempor si ut esequuntur?

Graph  
Infographic II.

Sub-Section  
statistic part II

Graph 
Infographic I

Statistics 

Statistics

1%

12%

24%

48%

96%
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EXAMPLE  
OF CHART TITLE 

Excepturi sint occa 

ecati cupidi tate non 

provident, similique 

Stat Description,  
Source, 2016

EXAMPLE  
OF CHART TITLE 

Excepturi sint occa 

ecati cupidi tate non 

provident, similique 

Stat Description,  
Source, 2016

EXAMPLE  
OF CHART TITLE 

Excepturi sint occa 

ecati cupidi tate non 

provident, similique 

Stat Description,  
Source, 2016

EXAMPLE  
OF CHART TITLE 

Excepturi sint occa 
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E-mail signature

The email signature is a very important element 

in brand communication. The exchange of emails 

with the appropriate signature establishes 

the brand image in the minds of the customer.

Add HTML email 
signature in Apple Mail

3

2

1 Create a signature in Apple Mail

	– Go to Apple Mail > Preferences… > Signatures 

and click the "+" button at the bottom of the 

second column (your signatures list).

	– Give your new signature a title and leave it at 

that (you don’t need to enter any text in the 

third (content) column, as you’ll be replacing 

this content later). Drag the signature (from 

the second column) on top of the email 

account you would like it to be associated with.

	– Quit Mail.

Prepare the signatures file

	– In the Signatures folder (if you’ve got a lot of 

files in this folder, view the folder as a list and 

order by the Date Modified column) locate the 

newest file that ends in .mailsignature and has 

lots of letters and numbers as the file name. 

	– Right-Click or CTRL-Click on the signature and 

choose Open With > TextEdit.

	– Delete all text starting from <body

Open the Signatures folder

	– The quickest way of doing this is go to go your Finder and 

in the top menu bar click Go > Go to Folder… and enter 

“~/Library/Mail/” (excluding the quote marks). 

Now, you might see a few folders here. 

	– Select the latest “V” folder. For example if you various 

folder starting with “V” then open the latest one e.g. 

Apple Mojave is now V6. 

	– Now open MailData > Signatures.
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Install HTML Email Signature 
for Google Gmail

4 Paste the HTML Signature

	– Open your new HTML Signature file 

(that your designer/developer provided) 

in TextEdit and copy the text and paste 

into position in the .mailsignature file 

you’ve just opened.

	– If when pasting you get prompted with 

“The file is locked”, simply click the 

“Unlock” button.

	– Save the file (Command-S)

5 Lock the file

Click the file title in the top document bar 

and check the “Locked” checkbox.

6 Look at your new 
signature

Open Apple Mail and create a 

new email (File > New Message). 

Select your new email signature 

from the Signatures dropdown 

and there you have it!

1

4

3

Copy HTML email signature design

Open your HTML email signature file with a 

web browser. Select the entire signature design 

(Command+A) and copy (Command+C) it onto 

your clipboard. You may also go to Edit > Select 

All and then Edit > Copy

2 Go to Settings in Gmail

Find the machine bearing icon on the upper right 

corner of Gmail. Click and go to Settings on the 

drop down menu.

Save changes

Scroll all the way down to the bottom. 

Click on “Save Changes”.

Paste HTML email signature

Under the General tab in Settings, scroll down 

to the Signature section. Click anywhere inside 

the Signature edit box. Paste the HTML email 

signature design you have stored in the clipboard.
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Install HTML Email Signature 
for iOS Mail App

1 Copy your email signature

	– Open your email signature file in your 

web app. Safari or Chrome app are 

recommended. 

Example: http://www.prmg.com.au/prmg-

email/prmg-mail-JAY-LEVY.html

	– Tap on the signature text and hold, then 

drag the selection handles to the bottom 

of the signature and the top

	– Tap Copy

2 Open Mail Settings

	– Closeout of your web app

	– Open Settings, then scroll down and 

select Mail

	– In your Mail Settings, scroll down to the 

bottom and select Signature

3 Paste email signature

	– Select Per Account

	– Tap inside the field of the email account 

you wish to install your signature into

	– Tap again and hold, then select Paste

	– Shake your device and select Undo

4 Open Mail App

	– Close your Settings

	– Open your Mail App and compose  

a new email

	– You should see that your email  

signature is automatically inserting  

and looks great!
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Envelope Letterhead
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Coffee cup Billboard
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Lanyard Roll-up
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Stamps Bags
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